Epson WorkForce™ 30 Series

Quick Guide

Basic Printing
Maintaining Your Printer
Solving Problems
## Contents

**Introduction** ............................................. 3

**Loading Paper** ........................................ 4
Using Special Papers ....................................... 6

**Basic Printing** ......................................... 8
Printing in Windows ....................................... 8
Printing With a Macintosh ................................. 10
Selecting the Correct Paper Type ......................... 15

**Maintaining Your Printer** ............................. 16
Checking the Print Head Nozzles ......................... 16
Cleaning the Print Head .................................. 17
Checking the Ink Cartridge Status ...................... 18
Replacing Ink Cartridges ................................. 19

**Solving Problems** ...................................... 24
Checking for Software Updates ......................... 24
Error Indicators ........................................... 25
Problems and Solutions .................................. 26
Where To Get Help ......................................... 28

**Notices** .................................................. 29
Introduction

After you have set up your Epson WorkForce™ 30 Series printer as described on the Start Here sheet, turn here to:

- Load paper
- Get the basic steps for printing from your computer
- Perform routine maintenance
- Solve simple problems

For additional instructions, see the online Epson Information Center by clicking the WorkForce 30 Series Info Center icon on your desktop. With Windows, you can also click Start or , select Programs or All Programs, select EPSON, select WorkForce 30 Series Info Center, and click WorkForce 30 Series Info Center.

Please follow these guidelines as you read your instructions:

**Warning:**
Warnings must be followed carefully to avoid bodily injury.

**Caution:**
Cautions must be observed to avoid damage to your equipment.

**Note:**
Notes contain important information about your product.

**Tip:**
Tips contain hints for better printing.
Loading Paper

1. Open the paper support.

2. Open the output tray and pull out the extensions.

3. Squeeze the tab on the edge guide and slide it left.
4. Insert the paper, printable side up, against the right edge guide and beneath the tabs. (The printable side is whiter or brighter on some papers.) Always load paper short edge first, even for landscape printing.

5. Slide the left edge guide against the left edge of the paper (but not too tightly). You can load up to 100 sheets of plain paper at 20 lb (75 g/m²) and up to 20 sheets of matte or photo paper (see the online *Epson Information Center* for capacity guidelines on other paper types).

**Note:**
The type of paper you choose affects the way your printout looks, so be sure to select the correct paper for your job. If you are just printing a rough draft, plain paper is fine. However, for the best results, you’ll want to use one of Epson’s special ink jet papers designed for your printer.
## Using Special Papers

Epson® offers a wide array of high quality papers, making it easy to maximize the impact of your presentations and other projects.

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Size</th>
<th>Part number</th>
<th>Sheet count</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Epson Bright White Paper</strong></td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041586</td>
<td>500</td>
</tr>
<tr>
<td><strong>Epson Photo Paper Glossy</strong></td>
<td>Borderless 4 × 6 inches</td>
<td>S041134, S041671,</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>S041809, S042038</td>
<td>20, 50, 50</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041141, S041649,</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>S041271</td>
<td>20, 50, 100</td>
</tr>
<tr>
<td><strong>Epson Premium Photo Paper Glossy</strong></td>
<td>Borderless 4 × 6 inches</td>
<td>S041808, S041727</td>
<td>40, 100</td>
</tr>
<tr>
<td></td>
<td>Borderless 5 × 7 inches</td>
<td>S041464</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Borderless 8 × 10 inches</td>
<td>S041465</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches)</td>
<td>S042183, S041667</td>
<td>25, 50</td>
</tr>
<tr>
<td><strong>Epson Ultra Premium Photo Paper Glossy</strong></td>
<td>Borderless 4 × 6 inches</td>
<td>S042181, S042174</td>
<td>60, 100</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches)</td>
<td>S042182, S042175</td>
<td>25, 50</td>
</tr>
<tr>
<td></td>
<td>Borderless 5 × 7 inches</td>
<td>S041945</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Borderless 8 × 10 inches</td>
<td>S041946</td>
<td>20</td>
</tr>
<tr>
<td><strong>Epson Premium Photo Paper Semi-gloss</strong></td>
<td>Borderless 4 × 6 inches</td>
<td>S041982</td>
<td>40</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041331</td>
<td>20</td>
</tr>
<tr>
<td><strong>Epson Presentation Paper Matte</strong></td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041062</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>Legal (8.5 × 14 inches)</td>
<td>S041067</td>
<td>100</td>
</tr>
<tr>
<td><strong>Epson Premium Presentation Paper Matte</strong></td>
<td>Borderless 8 × 10 inches</td>
<td>S041467</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041257, S042180</td>
<td>50, 100</td>
</tr>
</tbody>
</table>
You can purchase genuine Epson ink and paper at Epson Supplies Central℠ at [www.epson.com/ink3](http://www.epson.com/ink3) (U.S. sales) or [www.epson.ca](http://www.epson.ca) (Canadian sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766).

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Size</th>
<th>Part number</th>
<th>Sheet count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Premium Presentation Paper Matte Double-sided</td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041568</td>
<td>50</td>
</tr>
<tr>
<td>Epson Ultra Premium Presentation Paper Matte</td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041341</td>
<td>50</td>
</tr>
<tr>
<td>Epson Photo Quality Self-adhesive Sheets</td>
<td>A4 (8.3 × 11.7 inches)</td>
<td>S041106</td>
<td>10</td>
</tr>
<tr>
<td>Epson Iron-on Cool Peel Transfer paper</td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041153</td>
<td>10</td>
</tr>
</tbody>
</table>
Basic Printing

This section describes the basic steps for printing a document or photo stored on your Windows® or Macintosh® computer.

**Note:**
For detailed instructions on printing, see the online Epson Information Center.

Before you start, make sure you’ve installed your printer software and connected the WorkForce 30 Series printer to your computer as described on the Start Here sheet.

**Tip:**
It’s a good idea to check for updates to your WorkForce 30 Series software (see page 24 for instructions).

---

### Printing in Windows

1. Load paper (see page 4).
2. Open your document or photo in a Windows program.
3. Open the File menu and select Print. You see a window like this one:

   ![Select EPSON WorkForce 30 Series](image)

   Click here to open your printer software

---

8 Basic Printing
4. Make sure **EPSON WorkForce 30 Series** is selected, then click the **Preferences** or **Properties** button.

   (If you see a **Setup**, **Printer**, or **Options** button, click it. Then click **Preferences** or **Properties** on the next screen.)

5. On the Main tab, select the basic print settings:

   Select the type of document you’re printing (choose **Photo** or **Best Photo** for pictures)

   Select your paper **Type**

   Select your paper **Size**

   Click here for borderless photos

   Select your document **Orientation**

   Make sure you choose the correct paper **Type** setting for the paper you are using (see page 15 for details).

   **Note:**
   For quick access to the most common settings, click the **Shortcuts** tab and select one of the presets. You can create your own presets by clicking the **Save Settings** button on the Advanced tab.

6. For more printing options, click the **Advanced** tab.

   **Note:**
   For more information about basic print settings or advanced settings, click **Help** button or see your online **Epson Information Center**.
7. If you want to change the layout settings, click the Page Layout tab and select settings as necessary.

8. Click OK to save your settings, then click OK or Print to start printing. This window appears and shows the progress of your print job.

---

**Printing With a Macintosh**

See the section below for your Mac OS® operating system.

**Mac OS X 10.5**

1. Load paper (see page 4).

2. Open your document or a photo in an application.

3. Open the File menu and select Print.

4. Select EPSON WorkForce 30 as the Printer setting.

5. Click the arrow to expand the Print window, if necessary.

6. Select the basic copy and page settings. For borderless photos, choose a Paper Size setting with a Sheet Feeder - Borderless option.
Note:
If the setting you want isn’t shown (for example, Scale), check for it in your application before printing. Or check for it in the settings for your application at the bottom of this window.

7. Choose Print Settings from the pop-up menu, and select the following print settings:
8. Choose any other printing options you may need from the pop-up menu. See the online *Epson Information Center* for details.

9. Click Print.

10. To monitor your print job, click the printer icon in the dock.

### Mac OS X 10.3 to 10.4

1. Load paper (see page 4).

2. Open your document or a photo in an application.

3. Select **Page Setup** from the File menu. Make the following settings:

   - Select **WorkForce 30**
   - Select your **Paper Size**
   - Select your document or image orientation

   For borderless printing, choose a **Sheet Feeder - Borderless** option in the Paper Size list for your paper size (US Letter, 8 × 10 in, 4 × 6 in, or 5 × 7 in).

4. Click OK to close the Page Setup window.
5. Select Print from the File menu. You see a window like this one:

6. Choose Print Settings from the pop-up menu and select the following settings as necessary:

   ![Print Settings Window]

   - Select WorkForce 30
   - Select Print Settings
   - Select your Media Type (see page 15)
   - Select Color or Black Ink Only output
   - Select higher quality or faster printing (if available)
   - Select Automatic mode

   **Note:**
   In certain programs, you may need to select Advanced before you can select Print Settings. For more information about printer settings, click the ? button.

7. Choose any other printing options you may need from the pop-up menu. See your online Epson Information Center for details.

8. Click the Advanced button to change additional settings.

   **Note:**
   For more information on advanced settings, click ? or see your online Epson Information Center.

9. Click Print.
10. To monitor the progress of your print job, click the printer icon when it appears in the dock on the bottom of your desktop.

You see a screen like this:

11. When you're finished, close the printer window.
Selecting the Correct Paper Type

Select the correct Type (see page 9) or Media Type (see page 13) setting in your printer software:

<table>
<thead>
<tr>
<th>For this paper</th>
<th>Select this setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>Plain Paper/Bright White Paper</td>
</tr>
<tr>
<td>Epson Bright White Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td></td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>Ultra Premium Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>Premium Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td>Premium Photo Paper Semi-Gloss</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td>Premium Presentation Paper Matte</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte Double-sided</td>
<td></td>
</tr>
<tr>
<td>Epson Ultra Premium Presentation Paper Matte Matte</td>
<td></td>
</tr>
<tr>
<td>Epson Photo Quality Self-adhesive Sheets</td>
<td></td>
</tr>
<tr>
<td>Epson Iron-on Cool Peel Transfer paper</td>
<td></td>
</tr>
<tr>
<td>Envelopes</td>
<td>Envelope</td>
</tr>
</tbody>
</table>
Maintaining Your Printer

If you notice a decline in print quality, follow the instructions in this chapter for:

- “Checking the Print Head Nozzles” (see below)
- “Cleaning the Print Head” on page 17
- “Checking the Ink Cartridge Status” on page 18
- “Replacing Ink Cartridges” on page 19

**Caution:**
To keep your WorkForce 30 Series looking like new, don’t place anything on top of the cover or use it as a writing surface. If you need to clean the cover, use only a soft, non-abrasive microfiber-type cloth.

### Checking the Print Head Nozzles

If your printouts are faint or have gaps in them, some of the nozzles in the print head may be clogged or ink may be running low in one or more of the ink cartridges. Follow the steps below to check the print head nozzles.

1. Turn off the printer.
2. Load letter-size paper in the sheet feeder.
3. Hold down the \[ paper button as you press the \( power button, then hold both buttons down until the \( power light begins to flash. The printer turns on and prints a test pattern.

![Print head nozzles are clean:](image)

![Print head needs to be cleaned:](image)

If the pattern does not look good, try cleaning the print head. See page 17.
Cleaning the Print Head

If your printouts are unexpectedly light or faint, or you notice light or dark bands across your printout, you may need to clean the print head. This unclogs the nozzles so they can deliver ink properly. Run a nozzle check as described on page 16 to see if the print head needs cleaning.

Note:
Print head cleaning uses ink, so clean it only if quality declines and the nozzle check indicates that the print head needs to be cleaned.

If the ink light comes on or flashes, you cannot clean the print head as described below. In this case, replace the appropriate ink cartridge first (see page 19).

1. Make sure the printer is on and the ink light is off.
2. Hold down the ink button for 3 seconds until the power light starts flashing. The printer runs a head cleaning cycle.
   - Caution:
     Never turn off the printer while head cleaning is in progress. You may damage it.
3. When the power light stops flashing, run a nozzle check (as described on page 16) to verify that the print head is clean.
4. If there are still gaps or lines, or the test patterns are faint, run another cleaning cycle and check the nozzles again.

Note:
If you don’t see any improvement after cleaning the print head up to 4 times, turn off the printer and wait at least 6 hours. This lets any dried ink soften. Then try cleaning the print head again. If quality still does not improve, one of the ink cartridges may be old or damaged and needs to be replaced (see page 19).

Tip:
If you do not use your printer often, it is a good idea to print a few pages at least once a month to maintain good print quality.
Checking the Ink Cartridge Status

When the ink light starts flashing, one or more cartridges are low on ink. When the ink light stays on, you need to replace the cartridge(s).

You can also check the ink cartridge status using your printer software. See your online Epson Information Center for more information.

**Note:**
The WorkForce 30 Series requires two black ink cartridges. If you install different sizes of black ink cartridges (one high capacity and one standard capacity) in the printer at the same time, the black ink level indicators in the printer software may show one black cartridge being used more quickly than the other. This is normal. Please note that the ink level indicators in the printer software are estimates only.

**Caution:**
You cannot print if one or more cartridges are expended. Leave the expended cartridge(s) installed until you have obtained a replacement, or the ink remaining in the print head nozzles may dry out.

A window may appear on your screen if you try to print when ink is low. On a computer that is connected to the Internet, you may see a screen asking if you want to receive ink offers and other updates from Epson. Click Accept or Decline to continue.

**Note:**
To disable checking for ink offers or updates from Epson, see the instructions in your online Epson Information Center.

You can purchase genuine Epson ink and paper at Epson Supplies Central at [www.epson.com/ink3](http://www.epson.com/ink3) (U.S. sales) or [www.epson.ca](http://www.epson.ca) (Canadian sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766).
Use these part numbers when you order or purchase new ink cartridges:

<table>
<thead>
<tr>
<th>Ink Color</th>
<th>Standard capacity</th>
<th>High capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>69</td>
<td>68</td>
</tr>
<tr>
<td>Cyan</td>
<td>69</td>
<td>68</td>
</tr>
<tr>
<td>Magenta</td>
<td>69</td>
<td>68</td>
</tr>
<tr>
<td>Yellow</td>
<td>69</td>
<td>68</td>
</tr>
</tbody>
</table>

**Note:**
The WorkForce 30 Series requires two black ink cartridges.

The 68 High Capacity color ink cartridges are available only online.

We recommend that you use genuine Epson cartridges and do not refill them. The use of other products may affect your print quality and could result in printer damage.

Cartridge yields vary considerably based on images printed, print settings, paper type, frequency of use, and temperature. For print quality, a small amount of ink remains in the cartridge after the “replace cartridge” indicator comes on. The printer ships with full cartridges and part of the ink from the first cartridges is used for priming the printer.

For best printing results, use up a cartridge within six months of opening the package.

---

**Replacing Ink Cartridges**

Make sure you have a new ink cartridge before you begin. Once you start replacing a cartridge, you must complete all the steps in one session.

1. Make sure the printer is on.
2. Open the printer cover.
3. Press and release the \( \text{ink} \) button. The \( \text{power} \) power and \( \text{ink} \) ink lights flash.

   If one of the cartridges is low or expended, the printer moves that cartridge to the \( \text{expended ink} \) mark. Go to step 4.

   If no cartridges are low or expended, the print head moves to the ink replacement position. Go to step 5.

   ![Image of printer with ink lights and buttons]

**Note:**
Do not hold down the \( \text{ink} \) ink button for more than 3 seconds or the printer may start to clean the print head.

**Caution:**
Do not move the print head by hand; this may damage the printer. Always press the \( \text{ink} \) ink button to move it.

   Do not touch the flat white cable inside the WorkForce 30 Series.

4. Press the \( \text{ink} \) ink button again.

   ■ If another cartridge is low or expended, it moves to the \( \text{expended ink} \) mark.

   ■ Once the printer identifies all of the low or expended ink cartridges, the print head moves to the ink cartridge replacement position.

   ![Image of printer with ink lights and buttons]
5. Open the cartridge cover.

![Image of a printer with the cartridge cover open]

**Caution:**
Never attempt to open the cartridge cover when the print head is moving. Wait until the cartridges have moved to the replacement position.

6. Squeeze the tab at the back of the cartridge and lift it straight out. Dispose of it carefully. Do not take the used cartridge apart or try to refill it.

![Image of a person squeezing the tab of a cartridge]

**Warning:**
If ink gets on your hands, wash them thoroughly with soap and water. If ink gets into your eyes, flush them immediately with water. Keep cartridges out of the reach of children.
7. Before you open the new ink cartridge package, shake it four or five times. Then remove it from the package.

![Shake the ink cartridge](image)

**Caution:**
Do not touch the green chip on the front of the cartridge. This can damage the ink cartridge.

8. Remove the yellow tape from the bottom of the ink cartridge.

**Caution:**
If you do not remove the yellow tape before installing the ink cartridge, print quality may decline or you may not be able to print. Do not remove any other seals from the cartridges.

![Remove the yellow tape](image)

9. Place the new ink cartridge into the cartridge holder and push it down until it clicks into place.

![Place the ink cartridge](image)
10. Once you replace any other cartridges that need replacing, close the ink cartridge cover and press it until it clicks into place.

![Image of closing the cartridge cover]

11. Close the printer cover.

12. Press the ink button. The printer begins charging ink and the power light starts flashing. This takes about 1 1/2 minutes. When it’s finished, the power light stops flashing and remains on, and the ink light goes out.

**Caution:**
Never turn off the printer while the power light is flashing or you’ll waste ink.

If you removed a low or expended ink cartridge, you cannot reinstall and use the cartridge.

**Note:**
If the ink light stays on (not flashing), the ink cartridge may not be installed correctly. Press the ink button again and reinstall the ink cartridge until it clicks into place.
Solving Problems

If you have a problem with your WorkForce 30 Series printer, check the lights on the control panel to diagnose the cause.

You can also check “Problems and Solutions” on page 26 for basic troubleshooting suggestions, or double-click the WorkForce 30 Series Info Center icon on your computer desktop for more detailed help.

Checking for Software Updates

Periodically, it’s a good idea to check Epson’s support website for free updates to your WorkForce 30 Series software. Open your online Epson Information Center and select Download the Latest Software or visit Epson’s support website at epson.com/support (U.S.) or epson.ca (Canada).

With Windows, you can select Driver Update on the Maintenance tab in the printer settings window. You can also click Start or , select Programs or All Programs, select EPSON, select WorkForce 30 Series, and click Driver Update.
## Error Indicators

<table>
<thead>
<tr>
<th>Light status</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flashing</td>
<td>The printer cover is open.</td>
<td>Close the printer cover.</td>
</tr>
<tr>
<td>Flashing</td>
<td>No paper is loaded in the sheet feeder.</td>
<td>Load paper in the sheet feeder. See page 4.</td>
</tr>
<tr>
<td>Off</td>
<td>Multiple pages have been fed into the sheet feeder.</td>
<td>Press the paper button to eject the paper. Then reload the paper; see page 4.</td>
</tr>
<tr>
<td>An ink cartridge is running low on ink.</td>
<td>See page 18.</td>
<td></td>
</tr>
<tr>
<td>An ink cartridge is expended, incorrectly installed, or not compatible.</td>
<td>See page 18.</td>
<td></td>
</tr>
<tr>
<td>A part needs to be replaced.</td>
<td>Contact Epson; see page 28.</td>
<td></td>
</tr>
<tr>
<td>There is a problem with the printer.</td>
<td>Turn the printer off and then back on. If the error does not clear, contact Epson; see page 28.</td>
<td></td>
</tr>
</tbody>
</table>
Problems and Solutions

Check the solutions below if you're having trouble using your printer.

Paper Feeding Problems

■ Make sure the paper size settings are correct for the paper you loaded.

■ Make sure your paper is loaded short edge first and is positioned against the right edge guide with the left edge guide against its left side. Don’t load paper above the arrow mark inside the left edge guide.

■ If paper doesn’t feed, remove it from the sheet feeder. Flip through the stack to separate the sheets a little. Then reload the paper against the right edge guide, and slide the left edge guide against the paper (but not too tightly). Make sure the paper is not in front of the feeder guard.

■ Do not load too many sheets at once (up to 20 sheets of photo or matte paper and 100 sheets of 20 lb plain paper). See the online Epson Information Center for more information.

■ If paper is jammed, follow these steps to clear the jam:
  1. Press the paper button to eject the jammed paper. If the jammed paper is not ejected, go to the next step.
  2. If the paper is stuck near the sheet feeder or output tray, gently pull it out.
     If the paper is stuck inside, press the power button to turn off the printer. Open the printer cover and remove any paper inside, including any torn pieces. Do not pull the paper out backward; this can damage the sheet feeder. Close the printer cover, then turn the printer back on.

Print Quality Problems

If you have any problems with the print quality, try these solutions:

■ Load the paper printable side up (usually the whiter, brighter, or glossy side).

■ Make sure your paper isn’t damp or curled.

■ Use a support sheet with special paper or load your paper one sheet at a time. Remove sheets from the output tray so not too many collect at a time.
■ Make sure the type of paper you loaded matches the paper size and paper type settings in your printer software (see page 15).

■ For the best print quality, use Epson special paper (see page 6) and genuine Epson ink cartridges (see page 18).

■ If you notice light or dark bands across your printouts or they are too faint, you may need to clean the print head. This unclogs the nozzles so they can deliver ink properly. Run a nozzle check as described on page 16 to see if the print head needs cleaning.

■ Clean the print head as described on page 17.

■ If you notice jagged vertical lines, you may need to align the print head. See your online Epson Information Center for instructions.

■ The ink cartridges may be old or low on ink (see page 19 for instructions on replacing an ink cartridge).
Where To Get Help

Epson Technical Support

Epson provides these technical support services:

Internet Support
Visit Epson’s support website at epson.com/support and select your product for solutions to common problems. You can download drivers and documentation, get FAQs and troubleshooting advice, or e-mail Epson with your questions.

Speak to a Support Representative
Before you call Epson for support, please have the following information ready:

- Product name (WorkForce 30 Series)
- Product serial number (located on the label in back)
- Proof of purchase (such as a store receipt) and date of purchase
- Computer configuration
- Description of the problem

Then call:

- U.S.: (562) 276-7202, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM, Saturday
- Canada: (905) 709-2567, 6 AM to 6 PM, Pacific Time, Monday through Friday

Days and hours of support are subject to change without notice. Toll or long distance charges may apply.

Purchase Supplies and Accessories

You can purchase genuine Epson ink and paper at Epson Supplies Central at www.epson.com/ink3 (U.S. sales) or www.epson.ca (Canadian sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766).
Important Safety Instructions

Before using your WorkForce 30 Series printer, read and follow these safety instructions:

■ Be sure to follow all warnings and instructions marked on the printer.
■ Use only the type of power source indicated on the printer label.
■ Use only the power cord that comes with the printer. Use of another cord may cause fires or shock. Do not use the cord with any other equipment.
■ Place the printer near a wall outlet where the plug can be easily unplugged.
■ Avoid plugging the printer into an outlet on the same circuit as a photo copier or air control system that regularly switches on and off, or on an outlet controlled by a wall switch or timer.
■ Do not let the power cord become damaged or frayed.
■ If you use an extension cord with the printer, make sure the total ampere rating of the devices plugged into the extension cord does not exceed the cord’s ampere rating. Also, make sure the total ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet’s ampere rating.
■ Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.
■ Leave enough room around the printer for sufficient ventilation. Do not block or cover openings in the printer case or insert objects through the slots.
■ Do not place the printer near a radiator or heating vent or in direct sunlight.
■ Place the printer on a flat, stable surface that extends beyond its base in all directions. It will not operate properly if it is tilted or at an angle.
■ Make sure the back of the printer is at least 4 inches (10 cm) away from the wall.
■ Do not spill liquid on the printer.
■ Except as specifically explained in your documentation, do not attempt to service the printer yourself.
■ Unplug the printer and refer servicing to qualified service personnel under the following conditions: if the power cord or plug is damaged; if liquid has entered the product; if the product has been dropped or the case damaged; if the product does not operate normally or exhibits a distinct change in performance. Adjust only those controls that are covered by the operating instructions.
■ When storing or transporting the printer, do not tilt it, stand it on its side, or turn it upside down; otherwise ink may leak from the cartridges.

■ When connecting the printer to a computer or other device with a cable, ensure the correct orientation of the connectors. Each connector has only one correct orientation. Inserting a connector in the wrong orientation may damage both devices connected by the cable.

■ If damage occurs to the plug, replace the cord set or consult a qualified electrician. If there are fuses in the plug, make sure you replace them with fuses of the correct size and rating.

■ Leave enough space in front of the printer for the paper to be fully ejected.

■ Do not touch the flat white cable inside the printer.

■ Do not use aerosol products that contain flammable gases inside or around the printer. Doing so may cause fire.

■ Always turn off the printer using the power button, and wait until the power light stops flashing before unplugging the printer or cutting off power to the electrical outlet.

■ Before transporting the printer, make sure that the print head is in the home (far right) position and the ink cartridges are in place.

**Ink Cartridge Safety Instructions**

■ Keep ink cartridges out of the reach of children and do not drink the ink.

■ Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them immediately with water.

■ Do not put your hand inside the printer or touch any cartridges during printing.

■ Install a new ink cartridge immediately after removing an expended one. Leaving cartridges uninstalled can dry out the print head and may prevent the printer from printing.

■ If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and store it in the same environment as the printer. Note that there is a valve in the ink supply port, making covers or plugs unnecessary, but care is needed to prevent the ink from staining items that the cartridge touches. Do not touch the ink cartridge ink supply port or surrounding area.

■ Use an ink cartridge before the date printed on its package.

■ Do not dismantle an ink cartridge. This could damage the print head.

■ Store ink cartridges in a cool, dark place.
- After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room temperature for at least three hours before using it.
- Store ink cartridges with their labels facing upward. Do not store cartridges upside down.

**FCC Compliance Statement**

*For United States Users*

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio or television reception. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause interference to radio and television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

**WARNING**

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC Certification of this device and may cause interference levels which exceed the limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this device. If this equipment has more than one interface connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly approved by the manufacturer could void the user’s authority to operate the equipment.
For Canadian Users

This Class B digital apparatus complies with Canadian ICES-003.

*Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.*

Declaration of Conformity

According to 47CFR, Part 2 and 15 for: Class B Personal Computers and Peripherals; and/or CPU Boards and Power Supplies used with Class B Personal Computers:

We: Epson America, Inc.
Located at: MS 3-13
3840 Kilroy Airport Way
Long Beach, CA 90806
Telephone: (562) 290-5254

Declare under sole responsibility that the product identified herein, complies with 47CFR Part 2 and 15 of the FCC rules as a Class B digital device. Each product marketed is identical to the representative unit tested and found to be compliant with the standards. Records maintained continue to reflect the equipment being produced can be expected to be within the variation accepted, due to quantity production and testing on a statistical basis as required by 47CFR §2.909. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Trade Name: Epson
Type of Product: Ink jet printer
Model: B421B
Epson America, Inc., Limited Warranty

What Is Covered: Epson America, Inc. ("Epson") warrants to the original retail purchaser that the Epson printer covered by this limited warranty statement, if purchased and operated only in the United States or Canada, will be free from defects in workmanship and materials for a period of one (1) year from the date of original purchase. For warranty service, you must provide proof of the date of original purchase.

What Epson Will Do To Correct Problems: Should your Epson printer prove defective during the warranty period, please call the Epson ConnectionSM at (562) 276-7202 (U.S.) or (905) 709-2567 (Canada) for warranty repair instructions and return authorization. An Epson service technician will provide telephone diagnostic service to determine whether the printer requires service. If service is needed, Epson will, at its option, exchange or repair the printer without charge for parts or labor. If Epson authorizes an exchange for the defective unit, Epson will ship a replacement printer to you, freight prepaid, so long as you use an address in Canada or the U.S. (excluding Puerto Rico and U.S. Possessions). Shipments to other locations will be made freight collect. You are responsible for securely packaging the defective unit and returning it to Epson within five (5) working days of receipt of the replacement. Epson requires a debit or a credit card number to secure the cost of the replacement printer in the event that you fail to return the defective one. If Epson authorizes repair instead of exchange, Epson will direct you to send your printer to Epson or its authorized service center, where the printer will be repaired and sent back to you. You are responsible for packing the printer and for all costs to and from the Epson authorized service center. When warranty service involves the exchange of the printer or a part, the item replaced becomes Epson property. The replacement printer or part may be new or refurbished to the Epson standard of quality, and, at Epson’s option, may be another model of like kind and quality. Exchange products and parts assume the remaining warranty period of your original product covered by this limited warranty.

What This Warranty Does Not Cover: This warranty covers only normal use in the United States and Canada. Using this product for continuous production or similar high duty purposes is not considered normal use; damage, maintenance or service from such use will not be covered under this warranty. This warranty is not transferable. This warranty does not cover any color change or fading of prints or reimbursement of materials or services required for reprinting. This warranty does not cover damage to the Epson product caused by parts or supplies not manufactured, distributed or certified by Epson. This warranty does not cover ribbons, ink cartridges or third party parts, components, or peripheral devices added to the Epson product after its shipment from Epson, e.g., dealer or user-added boards or components. Epson is not responsible for warranty service should the Epson label or logo or the rating label or serial number be removed or should the product fail to be properly maintained or fail to function properly as a result of misuse, abuse, improper installation, neglect, improper shipping, damage caused by disasters such as fire, flood, and lightning, improper electrical current, software problems, interaction
with non-Epson products, or service other than by an Epson Authorized Servicer. If a claimed defect cannot be identified or reproduced, you will be held responsible for the costs incurred.

THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT OR FITNESS FOR A PARTICULAR PURPOSE. SOME LAWS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES. IF THESE LAWS APPLY, THEN ALL EXPRESS AND IMPLIED WARRANTIES ARE LIMITED TO THE WARRANTY PERIOD IDENTIFIED ABOVE. UNLESS STATED HEREIN, ANY STATEMENTS OR REPRESENTATIONS MADE BY ANY OTHER PERSON OR FIRM ARE VOID. IN NO EVENT SHALL EPSON OR ITS AFFILIATES BE LIABLE FOR ANY SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES RESULTING FROM THE USE OR INABILITY TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH OF WARRANTY OR ANY OTHER LEGAL THEORY. IN NO EVENT SHALL EPSON OR ITS AFFILIATES BE LIABLE FOR DAMAGES OF ANY KIND IN EXCESS OF THE ORIGINAL RETAIL PURCHASE PRICE OF THE PRODUCT.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts, and some jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the above limitations and exclusions may not apply to you. This warranty gives you specific legal rights and you may have other rights which vary from jurisdiction to jurisdiction.

To find the Epson Authorized Reseller nearest you, visit our website at:

To find the Epson Customer Care Center nearest you, visit:
http://www.epson.com/support.

You can also write to:
Epson America, Inc., P.O. Box 93012, Long Beach, CA 90809-3012
Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko Epson Corporation. The information contained herein is designed only for use with this Epson product. Epson is not responsible for any use of this information as applied to other equipment.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation’s operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or any consumable products other than those designated as Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic interference that occurs from the use of any interface cables other than those designated as Epson Approved Products by Seiko Epson Corporation.

A Note Concerning Responsible Use of Copyrighted Materials

Epson encourages each user to be responsible and respectful of the copyright laws when using any Epson product. While some countries’ laws permit limited copying or reuse of copyrighted material in certain circumstances, those circumstances may not be as broad as some people assume. Contact your legal advisor for any questions regarding copyright law.

Trademarks

Epson is a registered trademark, Epson Exceed Your Vision is a registered logomark, and Supplies Central is a service mark of Seiko Epson Corporation.

WorkForce is a trademark and Epson Connection is a service mark of Epson America, Inc.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. Epson disclaims any and all rights in those marks.

This information is subject to change without notice.

© 2013 Epson America, Inc. 9/13